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COPILOT live

POCKET PC 4
Quick Start Guide

CoPilot Help Files on Your Pocket PC

Now CoPilot Live includes Help files on your Pocket PC to assist you. After
launching CoPilot, tap Tools at the bottom of the screen then tap Help.

Important Note, Please Read:

Do not use this product in any way that interferes with safe and attentive
operation of a vehicle. The driver must remain alert at all times to actual road
conditions and obey all posted signs and traffic regulations. Always keep
your hands on the steering wheel and eyes on the road when driving!
While driving, either ask a passenger to operate CoPilot or pull over to the
side of the road when interacting with CoPilot on your Pocket PC.

1. Check the package contents

Your CoPilot Live package includes the following:

¢ Install/Data Disks

+ Quick Start Guide

¢GPS Receiver (not in software-only packages)

+ In-Vehicle Power Adapter (not in software-only packages)
+ Vent Mount (not in software-only packages)

* QuickStart storage card (not in all packages)

2. Uninstall any previous version

If you have a previous version of CoPilot installed on your Pocket PC and/or
desktop computer, you must uninstall it before updating. Make sure your
GPS receiver is NOT attached, then follow these steps:
(1) On your Pocket PC:

1. Tap the Start menu and select Settings/System/Remove Programs

2. Select Pocket CoPilot and tap Remove.

3. Select Pocket Speech and tap Remove.

4a. If you stored map data on a storage card:

i. Delete the Pocket CoPilot folder on the storage card. Tap Start, then
Programs/File Explorer/My Device/SD Card, then tap and hold on Pocket
CoPilot and select Delete from the menu.

4b. If you stored map data on your device memory:

i. Delete the Pocket CoPilot folder on My Device. Tap Start, then
Programs/File Explorer/My Device, then tap and hold on Pocket CoPilot
and select Delete from the menu.

(2) On your Desktop/Laptop computer:

Select Start/Settings/Control Panel.

Double-click Add/Remove Programs.

Select Pocket CoPilot and click on the Remove button.

If asked to confirm the removal of Pocket CoPilot and all of its
components, select YES.

5. If asked to remove shared files during the uninstall process, select
No To All.

Select Start/Search/Files or Folders and find the Pocket CoPilot folder.
7. Right-click the Pocket CoPilot folder and select Delete.
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3. Install CoPilot Live

NOTE: Make sure no previous version of CoPilot is installed (see above).

Two ways to install CoPilot Live are described on pages iii-iv. Use the Quick
Start Installation if your product shipped with a Quick Start storage card,
otherwise follow the Install From CD instructions.



Quick Start Installation

If your product shipped with a Quick Start storage card, just follow these
simple steps to get started with CoPilot Live. Otherwise skip to the Install From
CD section below.

(1) Ensure your Pocket PC is fully charged and powered on.
(2) Attach your GPS receiver to your Pocket PC.

(3) Insert the Quick Start storage card in your Pocket PC. The software and map
data will install automatically. If they do not, then follow these
additional steps on your Pocket PC:

a. Tap the Start menu and select Programs/File Explorer.

b. In the My Device folder, select your storage card (normally called Storage
Card, CF Card, or SD Card).

c. Select the 2577 folder and then tap AUTORUN. The software and map data
will install without desktop/laptop synchronization.

d. Skip to Step 5 (activate the software) on page 6.

Install From CD

If your product did not ship with a Quick Start storage card, follow these
instructions to get started with CoPilot Live. Your desktop/laptop and Pocket PC
should both be turned on. The cradle/cable for your mobile device must be
connected to your desktop either through a USB or Serial port. Your Pocket PC
should be connected to your desktop via ActiveSync.

If you plan to download CoPilot map data using a Storage Card Reader, it must be
installed and connected to your desktop/laptop. You can also use a PCMCIA
adapter for the storage card if you have a laptop.

(1) Insert the CoPilot Live Install Disk into your CD-ROM drive. When
prompted to choose a language, select one from the pick list and click OK.

(2) After clicking Yes to accept the Licence Agreement, enter your Product Key
Code from the cover of this Quick Start and click Next.

(3) Make sure Pocket PC Installation and Desktop Installation are
checked on the installation menu. Click Next.

(4) The installation will start with the text-to-speech software. Choose a Male or
Female Voice (both are standard TTS file), or Pre-recorded Sound Files
(WAV files, male voice) when prompted. The pre-recorded option saves space

on your Pocket PC, but provides less detailed driving instructions. Click
Next.

(5) Choose an installation location on the Pocket PC. The default is the device
memory (Yes). Recommended: To install to a storage card, click No and
choose Storage card from the drop-down pick list.

(6) When CoPilot has been installed to your Pocket PC (this will take a few
minutes), you will be prompted to begin the desktop/laptop installation.
Click Next and follow the on-screen instructions.

(7) When the installation is complete, a CoPilot Live icon will appear on your
desktop or laptop.

NOTE to Navman GPS Jacket Users: If you are using this software with the
Navman GPS Jacket (the jacket will have the word NAVMAN molded into the
back of it and has a conical antenna), you must also install drivers for that jacket
separately:

1. Insert the CoPilot Live Install Disk into your CD-ROM drive.
2. Exit out of the Installation screen when it appears.

3. Open up My Computer, right-click on your CD-ROM drive and select
Explore from the pop-up menu.

4. Open the WInCE folder, then open the Legacy Drivers folder and copy
the file 3.1.1.COM.ALKNavman.arm.CAB to the My Documents
folder on your Pocket PC.

5. On your Pocket PC open File Explorer and go to My Device >
My Documents and single-tap the CAB file you just copied from your
computer. This will install the appropriate drivers.

6. You may have to unseat/reseat your iPAQ in the jacket in order for the
drivers to take effect.

4. Download map data

NOTE: CoPilot Live won’t open on your Pocket PC unless map data
has been downloaded first.

(1) Choose a Storage Location:

ﬂ 1. Open the CoPilot Live application on your desktop/laptop, then
a_ click the Data Download Wizard icon in the sidebar on the left.
Make sure your Pocket PC is synchronized.




2. Choose where you would like data stored on the Pocket PC.
CoPilot will scan your computer to detect which options are
available. If you choose an option other than the device memory,
click the pick list that appears and select a storage card name or the
drive letter of your storage card reader. Click Next.

NOTE: If data is stored on the device's memory and also on a Storage Card
in the device, CoPilot will use the Storage Card by default. To have it use
map data on device memory, you must remove the Storage Card.

(2) Select a Data Area:

Select City Radius to create a data region of a specified radius around

% a city of your choice:

1. In the City, Country or Postal Code box, type a City, Country (e.g.
bristol, uk) and press <Enter>.

2. Specify the Distance Around City to Download (e.g. 60) and press
<Enter>. Click Next.

3. Your selected data region will be displayed. A window will appear
showing how much space you have available on your selected
destination (see Choose a Storage Location above) and how much
memory this data region will take up. If necessary, adjust the radius
to make sure your data region will fit on your selected destination.
Click Next.

4. Give your data region a name and click Next.
5. You will then be given the option to either select additional map data
or download selected areas to your Pocket PC. Click Download.

NOTE: Instead of City Radius you could select Map Area to download map
data within a chosen area (select and download data by drawing a box with your
mouse) or Trip to download map data for a specified trip.

(3) Download the Data:

_t 1. Clicking the Download icon will take you to a screen where
=l Available Area(s) for download are displayed on the left.

2. To designate an area to include in the download, highlight it and then click
on the right arrow button to move it to the Data Included in This
Download list on the right. To take an area off the list, highlight it and
click the left arrow button.

3. After confirming that the area(s) you would like to download are in the
Data Included in This Download list, click Download to complete the map
data download process.

5. Activate the software

NOTE: CoPilot won’t open unless map data has previously been down-
loaded from the CoPilot desktop application (see Step 4).

To launch CopPilot Live, first turn on your Pocket PC, attach the GPS receiver,
and insert your QuickStart card (if provided). Tap Start on your Pocket PC and
choose CoPilot Live from the drop-down menu.

If You Are Using a CoPilot GPS or Quick Start Card:

You will be prompted to enter your Product Key Code on your Pocket PC
(it can be found on the front cover of this Quick Start). Enter your Product Key
Code and skip to Step 6 (map region selection).

If You Are Using aThird Party GPS Receiver:

You must activate your CoPilot software in order to use it. The first time you
open CoPilot Live on your Pocket PC, the Activate screen will appear and you will
be asked to activate the software.

For Automatic Activation, follow the on-screen instructions:

1. Synchronize your Pocket PC with your desktop/laptop computer via
ActiveSync.

Connect your desktop/laptop to the Internet.

3. Tap Next when ready and enter your e-mail address when
prompted. CoPilot Live will be activated within a few seconds. Tap
Next to begin using CoPilot.

4. Select your desired map region (Step 6) and then see Step 7 (hard-
ware setup) to configure your GPS receiver.

If you are unable to synchronize your Pocket PC with your desktop/laptop but
have internet access, you can Activate Manually as follows:

1. On your Pocket PC, check Activate Manually and tap Next.

2. Enter your Product Key Code (see Quick Start front cover) where
indicated and tap Next. Your Licence Number will be displayed.

3. On your desktop/laptop, connect to the internet and browse to
http://activate.alk.com. Type in your Product Key Code, License
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Number, and E-mail Address where indicated and click Submit. Your
Activation Code will immediately be e-mailed to you.

4. On your Pocket PC, type in your Activation Code where
indicated and tap Activate. CoPilot will launch upon activation.

5. Select your desired map region (Step 6) and then see Step 7
(hardware setup) to configure your GPS receiver.

6. Map region selection

If you purchased CoPilot with a single region license, you will be asked to select a
region the first time you launch the software on your Pocket PC. Carefully choose
a region, as it cannot be changed once selected.

If you select Italy, for example, you will be able to use CoPilot's Italian street maps on
your Pocket PC. If you later want to use street maps from other regions, you will
need to purchase an update license from your dealer.

If you choose to activate a region other than the region pre-installed on your
QuickStart storage card, you will be required to download the selected region to
your storage card using the Data Download Wizard from within the CoPilot desktop
application. Additionally, you will not be able to use the data region that was pre-
installed on your card.
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7. In-vehicle hardware setup

WARNING: Never leave your GPS receiver in a closed vehicle when the
temperature might exceed 60° C, it could be damaged by the heat.

First turn on your Pocket PC, then make sure that the GPS receiver is attached
and powered and your engine is running before using CoPilot Live.

If you have a CoPilot vent mount and in-vehicle power adapter:
1. Attach the cable to the Pocket PC and insert it into your vehicle’s cigarette
lighter socket. Make sure it is firmly seated (the red light should be on).
2. Attach the vent mount clips to the vent in your vehicle, in a position that
will allow you to be comfortable as you view and operate CoPilot.
3. Slide the Pocket PC into the vent mount, and make sure it is turned on.

Third Party GPS Receiver setup:
On your Pocket PC, select Options from CoPilot’s Tools menu. Then select
the GPS tab (bottom) and tap on Auto Scan. CoPilot will scan
all COM Port and Baud Rate settings until it finds your GPS receiver.

8. Adjust the speech volume

To hear CoPilot Live’s voice prompts, the volume on your Pocket PC must be
turned all the way up. In the Pocket PC Start menu, go to Settings and tap on
Sounds and Notifications. Under System Volume, move the slide bar all the way to
the right. You can also use your Pocket PC’s keypad when CoPilot Live is open:
tap up until you reach the maximum volume.

9. Enter an address

NOTE: There is no need to enter a starting point. CoPilot Live uses GPS
positioning to determine your location automatically.

1. The first time you use CoPilot Live, you will be asked to enter your

nearest city to help speed up the initial GPS acquisition. Enter your city, country
(e.g. bristol, uk) and tap OK. You will only need to enter your nearest city the
first time you use CoPilot Live.
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2. Tap the Address button

Pleaiss Select Yaur

when asked to enter a e
destination. r <K
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3. Select a country from Auldirmin C

the drop-down menu.

4. Using the keyboard, type
in the name of a city.
Possible matches will be
provided. Tap the <Enter>

key to select the city. E|

If this is not your first use of
CoPilot Live, a pick list of
cities previously entered may
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appear.

Step 4 Step 5

5. In the Addr box, type
a street address (optional). Then tap <Enter>.

If there is an exact match in CoPilot’s database, your address will appear on the
Address list highlighted in blue. Tap <Enter> again to confirm your
destination. If no exact match was found, a list of possible matches appears.
Highlight one and tap <Enter>.

6. In the EditTrip screen, tap the =lr]e] ]

View Route button to begin é?
. . . . 19 Valn Sreei; Briwisl

receiving guidance instructions to

the destination you entered. Or
enter additional stops first.
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10. Start driving

Start driving! To toggle between the Driver Safety and the Passenger screens,
tap the Driver/Passenger button. The Driver Safety screen only shows maps
as you approach your next turn or when you're traveling slower than 10 m.p.h.

Take Ramp to Take Ramp to

M32 South M32 South

Driver Safety Screen Passenger Screen

Product Licensing & Updates

The CoPilot Live desktop software contains street-level maps for all of Europe, and
CoPilot is offered with different licenses that allow you to use some or all of these
maps on your Pocket PC. Licenses are available for the following:

(1) Single region - Detailed street-level maps for any of the following
regions: Alps Ski Region, Benelux (Belgium, the Netherlands, and
Luxembourg), France, Germany, Italy, Pyrenees, Scandinavia, and the United
Kingdom

(2) Pan-Europe - Complete street-level maps for all of Europe

After purchasing the license, go to CoPilot's Tools menu, select Update License/
activate, and input your new activation code. The CoPilot Live desktop software

already contains complete European maps, which can now be downloaded to your
Pocket PC for in-vehicle use. If you purchased CoPilot with a single region license

and later want to use street maps from other regions, you will need to

purchase an update license from your dealer.



Hints & Troubleshooting

To ensure proper GPS reception, make sure that your Pocket PC is vertically
mounted to your vent clip or windshield (not required if you are using the optional
external GPS antenna). Also make sure to properly set the time and date on your
Pocket PC.

The first acquisition can take from 5 to 15 minutes, and you can minimize this time
by positioning the GPS receiver with a clear view of the sky. Once initialized, the
unit should acquire satellite signals in 40 seconds or less.

If your Pocket PC “hangs” (does not respond to screen taps or button pressing),
reset it by inserting the stylus in the reset hole on the bottom, back, or side of
your Pocket PC.

Contact Information and Additional Help

For more detailed instructions and descriptions of CoPilot Live screens,

menus, and features, see the User’s Guide that came with the product. This
printable document, CoPilot Live.pdf, can be accessed on your desktop by selecting
Start/Programs/CoPilot Live-Pocket PC 4 (EU)/User Manual. Or see the CoPilot
Help Files in either your desktop (Help menu > Help Contents and Search) or
Pocket PC (Tools menu > Help) installation.

Also check out our Internet site at http://www.travroute.com/europe for
technical support documentation, posted answers to common questions, and
upgrades. You may also e-mail us at eutechsupport@travroute.com.
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Quick Reference: Pocket PC Guidance Screens

é? Proceed ahead as

name changes to
Tap the View Route A4 East
button to switch
from any screen to 78.8
start navigating. i

Current Road i M
(customizable) * Grittenham, UK
i 1131 &b 55 ]
Crossroad

(customizable) ETA and Distance

Next Turn
Instruction

Distance to
Next Turn

Driver/Passenger
Toggle

Traffic
Incidence

Messaging

to Next Stop GPS Status

Tap anywhere except on the map in either the Driver Safety or

Passenger screen to display the toolbar and menus:

Use this button to
toggle between Map
view, Itinerary, and

Guidance screens

Edit Trip button
takes you to the Edit
Trip screen
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Detour button
gives you an
alternate route,
Cancel Detour
button puts you
back on original
route




Contents

QUICK STArt .....ccoveees s i
CoPilot Overview
Safety Warning ... 2
What's New inVersion 4.0? .......ccvveieineereenn. 2
Getting Started ... 3
Getting Started - Hardware. ... 3
Getting Started - Get Connected ..o, 4
Uninstalling a Previous Version 5
Installing COPilot LiVe ......ccccoovvvvvercreinieins 6
Changing the Voice Option At Any Time 8
Data Download To Your Pocket PC ..., 9
Step 1: Specify Where Data Is Stored ..........ccccooevenee 9
CoPilot QUICKStart........cccovvviieiiierseieieieis 10
Step 2: Choose a Data Selection Method ................. 11
Step 3: Select the Data
City RAIUS ... 13
MaP AFBA ... 15
] TS TTR 17
Step 4: Download the Data ..........cccoevevinininiineeninn. 19
POI Download OpPLioNS ... 20
THIP TranSIEr ..o 20
Importing Custom PIACES ..o 21
Software ACtIVAtION ... 23
Map Region Selection ... 25
In-Vehicle Hardware Setup ... 26
SPEECh VOIUME ... 26
Using Your Pocket PC for Guidance .................. 27
AAresS ENTIY ..o ssesnes 28
SEart DIiVING! ..o 30
Entering a Home Address ..

Entering a WOrk Address ...
Finding Points oOf INterest ......cccoooeovvvviniviinrnererninnns
Favorites ...,

Closing CoPilot
Map/Itinerary/Guidance TOggle ........ccoovrereriernirnnens 33
Customizing the Guidance SCreens ... 34
Trip Editing and Waypoints
Getting ETA’s and Distances ..
Picking Stops From the Map ......cccccccevvvrnrnennereennnn. 36

Detour FEAtUIE ... s 37
Selective ROULING ... snns 38
Contact INtegration ... 39
TOOl MeNU OPLIONS ..o 40
(@I (=T A @ o] o3I 41
MOdES ...ccvvrrirnens . 42
The GPS Menu .......ccceeeenn. .. 43
Open and Play GPS Tracks ..... o 44
Save Current LOCAtION ..........ccovrvrenrernerienernenneionan. 45
Reference: CoPilot Live on Your Pocket PC ............. 46
Trip Planning on Your Pocket PC ... 50
Saving and Loading Trip Itineraries .........ccovvvvvnenne 51
Trip Planning on Your Desktop ..., 52
Menus and Toolbar BUELONS ... 52
Reference: CoPilot Live on Your Desktop ................. 60
CoPilot Live Communications ... 65
POCKEL PC SELUP ..o 66
Automatic Vehicle Location (AVL) ..., 66
Send/Receive Messages - DesKtop ... 67
Receive/Respond To Messages - Pocket PC ............... 69
Send Trip Itinerary Updates - Desktop ..., 70
Receive Trip Itinerary Updates - Pocket PC ............. 71
Helpful HINTS ..o
About GPS Technology
Trouble-shOOtiNg ...
UsIiNg Help FIleS ...
Technical SUPPOIT ...




CoPilot Overview
Your CoPilot Live | Pocket PC 4 Includes:

*

Install/Data Disks

GPS Receiver (not in software-only packages)

In-Vehicle Power Adapter (not in software-only packages)
Vent Mount (not in software-only packages)

* QuickStart Storage Card (not in all packages)

* o o

Desktop PC Requirements

+  Microsoft Windows 95, 98, 2000, ME, XP or Windows NT®
(4.0 or higher)

¢ Pentium Il processor or better
¢ 12X CD-ROM or better

+ 64 MB of RAM and a hard drive with at least 65 MB
of available disk space

* Microsoft ActiveSync version 3.1 or later

Pocket PC Requirements
With Map Data on Storage Card

¢ Pocket PC running Windows CE 3.x or Pocket PC 2002

* MIPS, SH3 or StrongARM processor

¢ 4-7 MB of storage RAM

¢ 6-12 MB of program RAM (available for running programs)

* Storage Card recommended
(minimum 32MB, 64MB recommended)

GPS Requirements

* Standard NMEA GPS receiver* including:
+ CF GPS receivers
* iPAQ GPS Jacket
¢ Cabled GPS receivers
+  Wireless Bluetooth GPS receivers

* For information on purchasing a GPS receiver from ALK
Technologies, go to www.travroute.com/europe.

A Safety Warning

Always keep your hands on the steering wheel and eyes on the road when
driving!

Do not use this product in any way that interferes with safe and attentive operation
of a vehicle. When used in a vehicle, do not place the GPS receiver, antenna, power
supply, or your computer where it may strike the driver or passengers if the vehicle
turns sharply or stops abruptly. This product is designed, manufactured, and
intended as an aid to planning and navigating routes. The accuracy of the map data,
driving directions, and GPS tracking system is insufficient for this product to be used
for automated navigation or in any situation in which the failure of the product
could lead directly to death, personal injury, or physical or environmental damage.
The driver must remain alert at all times to actual road conditions and obey all
posted signs and traffic regulations.

TravRoute assumes no responsibility for any damage or injury resulting
from the use of this product.

What’s New in Version 4.0?

Enhancements and new features in CoPilot Live | Pocket PC 4 that we think you'l
like include:

¢+ Customizable Navigation Display - Now you can customize your
navigation screen to display the current road, crossroad, vehicle speed,
current time, elevation, and nearest town. ETA and distance to
destination are always displayed and constantly updated. Plus a new
Regional POI Download Option lets you choose which types of points of
interest you want displayed along with the map data you download, and
gives you complete access to millions of POIs!

* Faster GPS Acquisition - CoPilot Live now acquires a signal within
seconds from the time you begin.

* Trip Transfer - Trip itineraries created on your desktop can now be
downloaded to your Pocket PC for later use.

+ RV and Toll Avoidance Routing - Favor major roads and avoid sharp
turns and U-turns wherever possible using CoPilot’s new RV routing
option. Choose Toll Avoidance routing to minimize toll payments.

¢ Custom Place Importing - This new feature enables you to import
your own sets of addresses and download them to the Pocket PC as
Custom POls.

+ Downloadable Favorites - Now you can transfer all Favorites stored on
your desktop PC when downloading map data.

¢ Live Messaging and Real-time Tracking - Maintain two-way
communication with a driver who's using CoPilot Live and actually see
where he or she is currently located using your home PC! S



Getting Started - Hardware

Both your desktop/laptop and your Pocket PC must be turned on. The
cradle/cable for your mobile device must be connected to your desktop/laptop
computer through either the USB or Serial port.

If you plan to transfer the map data to your mobile device's main memory, or to
a Storage Card in the device, there are no more connections needed.

If you plan to transfer data to a Storage Card through a Storage Card Reader,
you must also have the reader installed and connected to your desktop/laptop.
You can also use a PCMCIA adapter for your Storage Card if you have a laptop.

Desktop Compules

L | *
|
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Getting Started - Get Connected

In order to successfully transfer data from your desktop to your Pocket PC,
you must have Microsoft ActiveSync 3.1 (or later) installed. This software is
necessary to connect the two machines and is provided by your Pocket PC
manufacturer. If you did not receive this software with your mobile device,
contact the distributor immediately.

-1 1. When connecting your Pocket
Skt " PC, if you_have not set up a
partnership between your Pocket
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instructions.




Uninstalling a Previous Version

If you have been using an earlier version of Pocket CoPilot it will be necessary
for you to uninstall the application and its data before installing CoPilot Live.

NOTE: When uninstalling CoPilot, your GPS receiver cannot be
attached. Before uninstalling, you must disconnect the receiver and perform a
soft restart. Then follow the steps outlined below:

(1) On your Pocket PC:

1. From the Start menu, select Settings/System/Remove Programs.
2. Select Pocket CoPilot and tap Remove.

3. Select Pocket Speech and tap Remove.

4a. If you stored map data on a storage card:

i. Delete the Pocket CoPilot folder on the storage card. Tap Start,
then Programs/File Explorer/My Device/SD Card, then tap and
hold on Pocket CoPilot and select Delete from the menu.

4b. If you stored map data on your device memory:

i. Delete the Pocket CoPilot folder on My Device. Tap Start, then
Programs/File Explorer/My Device, then tap and hold on Pocket
CoPilot and select Delete from the menu.

(2) On your Desktop/Laptop computer:

1. From the Start menu, select Settings/Control Panel.

2. Double-click Add/Remove Programs.

3. Select Pocket CoPilot and click on the Remove button.

4. If asked to confirm the removal of Pocket CoPilot and all of its
components, select YES.

5. If asked to remove shared files during the uninstall, select No To All.

6. Select Start/Search/Files or Folders and search for the Pocket CoPilot folder.

7. Right-click the Pocket CoPilot folder and select Delete.

Installing CoPilot Live

NOTE: You must uninstall any previous version of Pocket CoPilot from
your desktop/laptop and Pocket PC before proceeding (see above).

To install CoPilot Live, first turn on your computer and set up your Pocket PC.
Do NOT attach the GPS receiver yet, the application should not be
installed with the GPS receiver attached. Your Pocket PC should be
connected via ActiveSync, as described on p. 4.

The steps in the installation process are covered on the following pages.

To Install CoPilot Live:
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. Insert the CopPilot Live Install

Disk in your CD-ROM drive.
Have your Product Key Code
ready (you can find it on your
printed Quick Start). When
prompted to choose a language,
select one from the pick list then
click OK.

. After clicking Yes to accept the

License Agreement, enter your
Product Key Code and click
Next.

. Make sure there are check marks

next to Pocket PC Installation
and Desktop Installation.
(Your Pocket PC should be
connected with the desktop/
laptop before doing this part of
the installation). Click Next.

. The Installation Wizard will then

start installing to your Pocket PC,
beginning with the text-to-speech
software that delivers CoPilot
Live’s spoken driving instructions.
You'll be prompted to choose a
Male or Female Voice (both
are standard TTS files), or
Pre-recorded Sound Files
(WAV files, male voice). Choosing

-6-



w the pre-recorded option saves space a 9. When the installation is complete, a CoPilot Live

Famisearsg sy i s Fiom okl ceecs on your Pocket PC, but will give you —] icon will appear on your desktop or laptop. You
less detailed driving instructions. Click L= are now ready to start using CoPilot!

Next to continue. CoPilot Live

NOTE to Navman GPS Jacket Users: If you are using this software with the
Navman GPS Jacket (the jacket has the word NAVMAN molded into the back of it

5. Next, you will be prompted to choose and has a conical antenna), you must also install drivers for that jacket separately:

an installation location on the Pocket ) ) o )
PC. The default location is the Pocket 1. Insert the CoPilot Live Install Disk into your CD-ROM drive.
PC main memory (click Yes). To install 2. Exit out of the Installation screen when it appears.

to a storage card, click No, then 3. Open up My Computer, right-click on your CD-ROM drive and select
choose Storage card from the drop- Explore from the pop-up menu.

down pick list (recommended).

4. Open the WInCE folder, then open the Legacy Drivers folder and copy
the file 3.1.1.COM.ALKNavman.arm.CAB to the My Documents
folder on your Pocket PC.

5. On your Pocket PC open File Explorer and go to My Device > My
Documents and single-tap the CAB file you just copied from your
computer. This will install the appropriate drivers.

6. The installation to your Pocket PC will
take a few minutes. Check your Pocket
PC screen to determine when the

! installation is complete. 6. You may have to unseat/reseat your iPAQ in the jacket in order for the

e drivers to take effect.

7. When CopPilot has been installed
to your Pocket PC, you will be
prompted to begin the desktop/
laptop installation. Click Next and follow
the on-screen instructions.

Changing the Voice Option at Any Time

To change the voice CoPilot Live uses from male to female or vice versa at any time
after installation, you must first delete CoPilot from your Pocket PC (see Uninstalling
a Previous Version, p. 5, for how to uninstall the application). Then re-install CoPilot
Live to your Pocket PC, choosing only the Pocket PC Installation, and when you
are prompted to choose a voice option, make your selection.

| o e L i | 8. As the desktop installation 1. Insert the Install Disk into your CD-ROM drive, follow instructions.

m.:l'f} i p;oc_:eeds, you will be given the 2. Make sure ONLY Pocket PC Installation is checked, click Next, and
' choice to mstall_the C(.)P.'IOt Data select the voice option you want. Click Next again.
e to your hard drive. This is the . i
: recommended option and requires 3. Click Yes to reinstall Pocket Speech.
700 MB of available space. If you 4. Click No to reinstall CoPilot Live.
choose None, you will need to 5. Click Yes to install in the default directory if that's where you originally

insert the CoPilot Live Data Disk
each time you download data to
your Pocket PC or use CoPilot Live )
for trip planning on your desktop. 6. Tap OK on your Pocket PC to reinstall.

7. Tap Yes to All if prompted.

installed. If you installed CoPilot Live elsewhere, click No and choose the
appropriate location.

8. Click OK on your Desktop, then click Finish to complete the process.



Data Download to Your Pocket PC

To use CoPilot Live on your Pocket PC, you first need to download map data
from your desktop or laptop computer to your Pocket device. You select the data
to download from one or more regions (“data areas”) that you specify in the
CoPilot Live application on your desktop. It's a simple 4-step process.

Step 1: Specify Where Data Will Be Stored

To begin the data download process, open the CoPilot Live application on your
desktop/laptop, then click the Data Download Wizard icon or pick Data

Download Wizard from the File menu.

CoPilot Live gives you three options for downloading data:

1) directly to the Pocket device's memory,

2) to a Storage Card in the device, or

3) to a Storage Card through a Storage Card Reader.
You will be prompted to enter one of these choices before you can download.
CoPilot will detect which options are available to you.

NOTE: If there is data stored on the device's memory and also on a
Storage Card in the device, CoPilot will use the map data on the
Storage Card by default. To have it use the device's memory, you must
remove the Storage Card.

=t msssssss 5 1. To download to Pocket PC
Pl ol e Device Memory:
(In this example, CoPilot Live has
detected that there is no Storage
e Card in the device.) Click Next to
S P go to the Data Selection window.
See CoPilot QuickStart, p. 10, for a
description of software included in

- P . ———

e | downloads. See p. 20 for Options.
T aaamm——— 1] 2. To download to a Storage
P o L Card in the device:

(In this example, CoPilot Live has
detected that all options are

P e E—— ——

o amrnan o ke P e o .
e T available.) Select a storage card
- R name from the drop-down pick
list, then click Next to go to the
2 Data Selection window. See CoPilot

Quickstart, p. 10, for a description
of software included in down-
loads. See p. 20 for Options.

e 3. To download to a Storage

P R Card through a Card Reader:
i (In this example, again all options
By i bl . i .
i b i are available.) Pick the drive letter
e e associated with your Storage Card
o i e Reader, then click Next to go to

the Data Selection window. See
CoPilot QuicksStart below for a

description of software included in

downloads. See p. 20 for Options.
NOTE: You can also download to a Storage Card through a PCMCIA
adapter. Simply identify the drive letter associated with the adapter under the
Storage Card Reader option.

CoPilot QuickStart
Storage Card Application Download

If you are downloading map data to a Storage Card or Storage Card
Reader, you have the option to download a complete, ready-to-use
“QuickStart” version of CoPilot Live along with the data. Having the
QuckStart version on your Storage Card ensures that CoPilot Live will be
available even if you experience technical problems with your Pocket PC
and need to perform a hard reset. (During a hard reset, all installed
applications are deleted from the Pocket PC.) Inserting a storage card
with the QuickStart version will automatically install CoPilot,
and your map data will already be there!

The QuickStart option can be turned on or off in the final step of the
download process (see p. 19). By default this option is active and
the QuickStart download will be executed each time you
download map data.

The QuickStart needs 10 MB of space on your Storage Card. Once the
QuickStart has been copied, you can save time the next time you
download data by unchecking the Create QuickStart option in the final
Data Download Wizard screen before proceeding to download. You will
also want to uncheck this option if you do not have enough room on your
Storage Card for it.

If the QuickStart is copied onto your Storage Card and you need to
remove it, simply delete the folder that contains it. The folder will be
named either “2577”, “4000”, or “10003” depending on which type of
Pocket PC you are using.

-10 -



Data Download
Step 2: Choose a Data Selection Method
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After you specify a location where the data will be stored, you will be prompted
to select a region on the map to download. CoPilot allows you to download
data using one of the three methods described below.

See Data Download Step 3 beginning on page 13 for step-by-step instructions for
downloading data to your Pocket PC using each of these three methods.

City Radius - This method allows you to quickly select data in the shape of a
circle surrounding a city of your choice. In the Data Download Wizard you type
a city name and country abbreviation or postal code and enter the number of
miles you would like the radius
to extend around the city, then
click Next.

The Wizard displays a map that
shows the city and the radius
you chose. At this point you

- can zoom the map in and out
- using zoom buttons and adjust
the size of the data area by
altering the radius of the circle.

City Radius

-11 -

Map Area - This method of selecting data allows you to choose an area of data
by drawing a box on the Data Download Wizard's map screen.

Map Area

In the Wizard, you enter a city
name near which you would like
to select data, then click Next.
The map will zoom to that
location. Then you create a
box around the desired area by
clicking and dragging your
mouse across the map. The
street-level data within that box
will be selected.

At this point you can zoom
the map in and out using zoom
buttons and adjust the size of
the data area by redrawing

the box.

Trip - The Trip method of selecting data is by far the most customizable method.

This option allows you to run a trip and select street-level data specific to that trip,

thereby avoiding unneeded data
and saving valuable memory
space.

Once the trip is run, the Data
Download Wizard automatically
selects circles of data around
your origin and destination,

and a corridor of data along
your route. You can then click
Options to adjust the radius of
the circles and the width of the
corridor.

The Trip Itinerary for each trip
you download will be stored on
your Pocket PC (see Trip
Transfer, p. 20). Multiple trips can
be downloaded to the Pocket
PC for later use.

-12 -



Data Download
Step 3: Select Your Data

Use any of the three methods covered on the following pages (City Radius,
Map Area, or Trip) to select one or more regions and then download your data.

City Radius
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1. Click the City Radius icon.

@

2. Enter a City, Country or
Postal Code, and a radius
around the area that you
would like to download. Click
Next to verify that the area is
correct.

3. Using the Data Download

Wizard toolbar you can zoom
in or out, change the radius, or
go back to the previous screen.
When you are satisfied with
your selection, click Next.

Note: CoPilot’s available mem-
ory calculations subtract 15 MB
from the available memory on
your storage card (if you are
using one) to account for
support files.
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4. Name the selection.
Click Next.

5. You will return to the Data
Selection Menu where you can
select another data area if you
like, using any method. When
you finish selecting data areas,
click the Download icon and
you will be taken to the final
screen where you can build
your download.
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Map Area
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1. Click the Map Area icon.

I:l{2

2. Enter a City, Country or
Postal Code (address is
optional) within the area that
you would like to download.
Click Next.

3. Click and hold the left
mouse button and drag the
cursor to draw a box around
a desired area. The size of the
area will be displayed in the
toolbar. Click Next.

Note: CoPilot’s available
memory calculations subtract
15 MB from the available
memory on your storage card
(if you are using one) to
account for support files.
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4. Name the selection.
Click Next.

5. You will return to the Data
Selection Menu where you can
select another data area if you
like, using any method. When
you are finished selecting data
areas, click the Download icon
to go to the final screen where
you can build your download.
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Trip
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1. Click the Trip icon.

<

2. You now have three options for
entering stops on your trip. If
you choose the Cities and
Addresses tab you will need to
enter a City, Country or
Postal Code, press <Enter>,
and click the Add Stop button.

You may enter one or multiple
destinations. Use the buttons
to the right of the Itinerary to
zoom to a stop on the map,
change the order of stops, or
delete a stop.

3. If you choose the Points of
Interest tab, enter a City,
Country or Postal Code

and click the

Find button. |I|
You can specify search
parameters by selecting a POI

Category and/or Type (this
will speed up the search).
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3a. Highlight a selection, click
Select, then Add Stop.
When all your stops have
been entered, click Select
Data.

4. By default a 20 mile radius
around all stops and a width of
4 miles along the corridor
which connects them will be
highlighted. Note: CoPilot’s
available memory calculations
subtract 15 MB from the avalil-
able memory on your storage
card (If you are using one) to
account for support files.

5. To customize these

distances for any trip, click
Options and type a distance
in the appropriate box.

6. You will return to the Data
Selection Menu where you can
select another data area if you
like, using any method. When
you are finished selecting data
areas, click Download. Trip
itineraries that were created
using theTrip download method
will be transferred along with
map data. See p. 20.
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Data Download
Step 4: Download the Data

When you're ready to execute a download, the Wizard will display a list of
Available Area(s) for download on the left side of the window. To designate an
area to include in the download, click on it and then click on the right arrow
button to move it to the Data Included in This Download list.

Notice that the amount of available map memory and the memory required for
all the areas on the Included list is shown under the list. NOTE: CoPilot's
available memory calculations subtract 15 MB from the available memory on
your storage card (if you are using one) to account for support files.

If you need to move an area off the Included list, click on it and use the left
arrow button. To delete an area from memory, click on it and click Delete.
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IMPORTANT: Each data download overwrites the data that is already
on your Pocket PC. If any data areas listed under Available Areas are
already loaded on your Pocket PC, they will be overwritten by the new
download. Therefore, your download must include all areas that you wish to
have available on your Pocket PC.

Check Include EU Highway Network to download CoPilot’s complete
European Highway Network along with your data. This additional download
requires approximately 49 MB of space on your Pocket PC. When this network
is loaded, major roads, cities, and some points of interest outside your selected
data region will be shown on the map and you'll be able to receive guidance even
when you drive outside the downloaded data area(s).

Check Download Favorites to download your Favorites list from the Trip
Planner window on your dekstop along with map data. These addresses will then
be available as Favorites for trip entry on the Pocket PC.

Uncheck Create QuickStart if you do not want the CoPilot QuickStart
software copied to your Storage Card (see p. 10 for a description of this feature).

-19 -

POI Download Options

When you download a data region, you'll get all roads within that region (but not
roads outside the region). Also included with each download are regional points
of interest (POI) such as gas stations, hotels, restaurants, visitor attractions, etc.

CoPilot Live now lets you control the number and types of points of interest that
get downloaded along with your data areas. You can save space on your Pocket
PC by eliminating categories of POI that you're not interested in seeing.

To select which POI categories you want, choose POl Download Options from the
Edit menu in the desktop application or, when you first open the Data
Download Wizard, click the Options button in the Wizard. In the window that
opens, check the categories you wish to select. Click the plus sign next to each
category to see the included sub-categories.

Click Save Settings to save the set of categories you create. Click Restore
Default to return to CoPilot’s default categories.
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Trip Transfer

CoPilot Live now transfers whole trips to your Pocket PC when you use the Trip
option for data downloading. Any trip you create, including its Itinerary, is
automatically downloaded along with the surrounding data corridor and will
become the current trip on your Pocket PC. A .TRP file is created and placed in
the Save directory in the CoPilot installation folder on the Pocket PC. Subsequent
downloads will add more .TRP files to this folder. The number of trips that may
be stored is limited only by the available memory on your Pocket PC.

If multiple trips are downloaded, the last one to be added will open as the current
trip. Use OpenTrip in the pop-up Tools menu to open a stored .TRP file.
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Importing Custom Places

CoPilot Live’s Custom Place Import Wizard enables you to import addresses from
your Outlook Contacts database, an Excel file, or text file. (If you are using
another type of database or contact manager, you can export your contacts/
locations to an Excel or text file before importing them into CoPilot Live.)
These points are added to CoPilot’s POI database under the Custom category.
Once they are in the database, they are displayed on maps as pushpins and
included in search results when you search for points of interest on your Pocket
PC or in the Trip Planner window on your desktop/laptop.

To access the Wizard, choose Import Custom Places from the Tools menu in
Planning Mode on the desktop, then follow the step-by-step instructions given by
the Wizard.

Use the Data Import Status window to edit any addresses that were not accepted

during the importing process, then click Add to import the final list of addresses.

For more detailed instructions, refer to the CoPilot Live Help Files on your
desktop (Help Contents and Search in the Help menu).
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Editing Custom Places in the Database

After custom places have been added to the database, they can be edited at any
time. Select Manage Custom Places from the Tools menu, then highlight the
custom place you wish to edit, click Edit, and make your changes. Click Apply
when finished.

NOTE: By default, addresses entered as Custom Places are assigned to the
Custom POI category. You can change this assignment at any time by selecting
another Category from the drop-down pick list as you edit.
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Software Activation and Startup

NOTE: CoPilot Live won't open on your Pocket PC unless map data has been
previously downloaded from the CoPilot desktop application.

To launch CoPilot Live, first turn on your Pocket PC and make sure the GPS
receiver is attached. Have your Product Key Code ready (this code can be
found on the cover of the printed Quick Start in the CoPilot CD case).

On your Pocket PC, tap the Start menu and choose CoPilot Live from the drop-
down menu. If you are using a CoPilot GPS receiver you will need to enter your
Product Key Code. If you are using a third party receiver, you will be asked to
activate your CoPilot software.

If You Are Using a CoPilot GPS Receiver:

If you are using a CoPilot GPS receiver, you will be prompted to enter your
Product Key Code on your Pocket PC. Enter your Product Key Code and
skip to Map Region Selection on p. 25.

If You Are Using a Third Party GPS Receiver:

If you are using a third party GPS receiver, you must activate your CoPilot
software in order to use it. The first time you open CoPilot Live on your Pocket
PC, the Activate screen will appear and you will be asked to activate the software.

For Automatic Activation, follow the on-screen instructions:

1) Synchronize your Pocket PC with your desktop/laptop computer via
ActiveSync.

2) Connect your desktop/laptop to the Internet.

3) Tap Next when ready and enter your e-mail address when prompted.

CoPilot Live will be activated within a few seconds. Tap Next to begin
using CoPilot.

4) If you purchased CoPilot with a single region license, you will be asked
to select a region. See p. 25 for details.

5) To configure your GPS receiver, see Step 6 on p. 24.
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If you are unable to synchronize your Pocket PC with your desktop/laptop but have
internet access, you can Activate Manually as follows:

1) On your Pocket PC, check Activate Manually and tap Next.

2) Type in your Product Key Code where indicated and tap Next. The
following screen displays your License Number.

3) On your desktop/laptop, connect to the internet and browse to
http://activate.alk.com. Type in your Product Key Code, License
Number, and E-mail Address where indicated and click Submit. Your
Activation Code will immediately be e-mailed to you.

4) On your Pocket PC, type in your Activation Code where indicated and
tap Activate. CoPilot will launch upon activation.

5) If you purchased CoPilot with a single region license, you will be asked to
select a region. See p. 25 for details.

6) To configure your receiver, select Options from CoPilot’s Tools menu.
Then select the GPS tab (bottom) and tap on Auto Scan. CoPilot will
scan all COM Port and Baud Rate settings until it finds your GPS receiver.

Deactivation and License Update:

If you're planning to uninstall CoPilot Live from one Pocket device and install the
same version on another device, you need to deactivate the software on the first
device before installing it again. To do this, open CoPilot on your Pocket PC, tap

the Tools menu, then tap Update License. Then tap Deactivate in the License
Manager. Your Pocket PC must be synchronized for the deactivation process to take
effect. When you re-install CoPilot Live on another device, you will be asked to
activate it again.

Similarly, if you purchased CoPilot with a single region license and later want to use
street maps from other regions, you will need to purchase an update license from
your dealer and activate the new license.
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Map Region Selection

If you purchased CoPilot with a single region license, you will be asked to select a
region the first time you launch the software on your Pocket PC. Carefully
choose a region, as it cannot be changed once selected.

If you select Italy, for example, you will be able to use CoPilot's Italian street
maps on your Pocket PC. If you later want to use street maps from other
regions, you will need to purchase an update license from your dealer.

If you choose to activate a region other than the region pre-installed on your
QuickStart storage card, you will be required to download the selected region to
your storage card using the Data Download Wizard from within the CoPilot
desktop application. Additionally, you will not be able to use the data region that
was pre-installed on your card.

T 1. When prompted, pick a map

e il region from the pick list.
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2. You will be given a chance to
confirm your choice, or to go
back and choose again. Tap OK
when the region you want is
selected. This finalizes your
choice.
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In-vehicle Hardware Setup

WARNING: Never leave your GPS receiver in a closed vehicle that might exceed
600 C., it could be damaged by the heat.

First turn on your Pocket PC, then make sure that the GPS receiver is attached
and powered and your engine is running before using CoPilot Live.

If you have a CoPilot vent mount and in-vehicle power adapter:
1. Attach the cable to the Pocket PC and insert it into your vehicle’s
cigarette lighter socket. Make sure it is firmly seated (red light on).
2. Attach the vent mount clips to the vent in your vehicle, in a position that will
allow you to be comfortable as you view and operate CoPilot.
3. Slide the Pocket PC into the vent mount, and make sure it is turned on.

Third Party GPS Receiver setup:
On your Pocket PC, select Options from CoPilot’s Tools menu. Then select
the GPS tab (bottom) and tap on Auto Scan. CoPilot will scan all COM Port
and Baud Rate settings until it finds your GPS receiver.

Speech Volume

To hear CoPilot’s voice prompts, the volume on your Pocket PC must be turned
all the way up. In the Pocket PC Start menu, tap Settings and then tap on Sounds
and Notifications. Under System Volume, move the slide bar all the way to the right.
You can also use your Pocket PC’s keypad when CoPilot is open: tap up until you
reach the maximum volume.
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Using Your Pocket PC for Guidance

In CoPilot Live's Guidance Mode you will receive turn-by-turn route guidance
information as you travel. For your safety the Driver Safety screen will hide maps
when they are not necessary to avoid distractions. Using the Passenger screen the
map will be visible in half of the screen at all times.

REMINDER: CopPilot Live won't open on your Pocket PC unless map data has
been previously downloaded from the CoPilot desktop application.

In-vehicle Hardware Setup:

First turn on your Pocket PC, then make sure that the GPS receiver is attached
and powered and your engine is running before using CoPilot Live.

If you have a vent mount and in-vehicle power adapter:

1. Attach the cable to the Pocket PC and insert it into your vehicle’s cigarette
lighter socket. Make sure it is firmly seated (the red light should be on).

2. Attach the vent mount clips to the vent in your vehicle, in a position that will
allow you to be comfortable as you view and operate CoPilot.

3. Slide the Pocket PC into the vent mount, and make sure it is turned on.

Launch CoPilot Live:

1. To launch the CoPilot Live program,
tap Start and choose “CoPilot Live”
from the drop-down menu. Because you
lwve have the GPS receiver attached and

PacuTPCA powered, CoPilot assumes that you are
Fos Fooscmian pi ORE Rmvigamian

on the road ready to drive, and opens in
J'JI ( Guidance Mode to get you on your way
el quickly and easily.
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2. The first time you use CoPilot Live,
you will be asked to enter your current
location to help speed up the initial GPS
acquisition. Enter your city, country

(e.g. bristol, uk) and tap OK.

PLEASE NOTE: You will only

need to enter your initial city the
first time you use CoPilot Live.
For subsequent uses, CoPilot will
remember your last location
automatically.

Wealonme b CoPikat

Mloase antad
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3. CopPilot will then provide you with a
number of different ways to enter an
address. You can:

E Horme a) Program your Home address.

Work

Please Selecl Your
Destinatian:

b) Program your Work address.
¢) Enter a new Address.
) Favorite List d) Select a destination from your

e Favorite List, or
B e) Search for a Point of Interest
ﬂ Poimt of Interest

Tap the appropriate button to choose the
option you would like to use.

Address Entry

NOTE: There is no need to enter a starting point. CoPilot Live uses GPS
positioning to determine your location automatically.

%_»

fupadl Rablrris

Tap the e
Address City |
button.

T"I!'IEIJI]IIHI!II]I!IF_II'II'I
qld [alnl]lE]

m

Select a country from the  In the Addr box, type in the
drop-down menu. Using street address (optional). Then
the keyboard, type in the tap the <Enter> key. If there
name of a city or a postal is an exact match in CoPilot’s
code. Tap the <Enter> key database, your address will

to view possible matches or appear on the Address list

to select your city. I£| highlighted in blue. Tap

<Enter> again to enter it. If

no exact match was found, a list
If this is not your first use of of possible matches appears.
CoPilot Live, a pick list of Highlight one and tap <Enter>.
cities previously entered may Tap the Name box to enter a
appear. name (optional), type in a name,

then tap OK.
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Once you enter a destination, CoPilot will
display the Edit Trip screen. At this point
you can enter additional stops using the

19 ¢ale Street, Bristol

tool bar or begin receiving guidance to the
al. = - " destination you entered by tapping the View
4 Route button (see below).
#ag | To add additional stops, tap one of the

trip entry buttons on the tool bar at the
top of the screen. Each option is described
on the following pages.

To begin your trip, simply tap the

o
il 19 Wak Stroct

Start Driving!

Proceed ahead as

e

Tap the View Route button
to switch from any screen to

start navigating.

A4 East

Current Road

name changes to

View Route button and start driving!

Nearest Town
(customizable)

(customizable) PR

& Dritenham, LUK

Take Ramp to

View Route
button

To return to the Edit Trip screen from the navigation screen at any
time, first tap anywhere above or to the side of the map to bring up the tool bar.
Then tap the Edit Trip button.

BHO0EES

Take Ramp to ; 11 Floral Brees, Londan, UK

M4 East 11 = T 13
Edit Trip =, -
button LW |
!: ki ﬁ’gﬂh

[ L B
LI i1
Tl G o omdaras) [

-29 -

Next Turn
Instruction

Distance to
Next Turn

Driver/Passenger
Toggle

Traffic
Incidence

ETA and Distance
to Next Stop

GPS Status

Start driving and enjoy CoPilot’s spoken instructions, continuously updated maps
and ETA’s, and automatic route recalculation capabilities.

Entering a Home Address

|
1

Tap the Home
button in the
Edit Trip screen.
The first time
you use this
button, you will
be prompted to
enter your Home
Address.

Enter the City or Postal
Code and address. Tap
OK and it will be saved.

| Is] |3
Tawh (P35 Hade { G ] -.

Now you can tap the Home
button to enter your home
as a stop. To change your
home address, see Favorites
p. 32.
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Entering a Work Address

Tap the
Work button.
The first time
you use this
button, you'll
be prompted
to enter your
Work Address.

-

Enter the City or Postal
Code, Address, and
(optionally) Name of your
workplace. Tap OK to
save it.

Barsiness Week, 1 &lbomarles Sy

i [ 1
" 5k i
=
L
"
Chl | ]
Tasks [ bade {udance] o

In later uses tapping the
Work button will enter your
workplace as a stop. To
change your work address in
the future, see Favorites p. 32.

Finding Points of Interest

- e e -J

Tipe |-.-|=|t-u- Abtractions -
rhn'il | | Find
Tap the Points  [Points of Interest | Mile
of Interest
button to search Ciodumnin g-:
for and/or enter Gusrds : -
a point of interest i[z % T80 [0 = [=]4
as a destination Afwie|ritiriu]i|ajn
) & |d|d|Tr ] Eilli
i |wjc|¥|b|lmjm| . |.} -
- | ]

Select a country from
the drop-down menu,
enter a City, and choose
a Type from the drop-down
menu. Tap Find to execute
the search.

Select from the pick list
of nearby POls that best
match your description by
tapping with your stylus.
Your choice will then be
entered as a destination.
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Favorites
BOEEE
11 Prowinoe Line Rood, Sil i)
‘ Technakoghes, b, 1000 HY
140} Fissams Sireat, Prinoeion, A
s, P02 Caln Court, Belle Wi
| ] I =
Tap the Favorites button. gﬁ

A drop-down list will appear,
providing quick access to the
last 50 destinations that you

entered.

L |
npmi.mm

Highlight a Favorite and tap Edit to edit the address or name of the Favorite. To
change which Favorite is assigned to the Home or Work buttons, tap the Tools

menu, select Options, and tap on the Favorites tab. Highlight the one you wish to

change and tap either Home, Work, or Favorite.

NOTE: When your Favorites list is filled (50), each new address will
replace the address that has been inactive for the longest period of
time.

To Save Your Current Location As a Favorite:

You must be receiving GPS data to save your current location as a favorite.
Tap the GPS menu and then select Save Current Location.

A prompt will ask you to assign
a location name to your current
latitude/longitude position. After
you enter a name, your current
location will be saved in the
Favorites list.

BERREA

Turn beft on
Farliament Streat.

Closing CoPilot

To exit the CoPilot Live application, select Exit from the pop-up Tools menu at the
bottom of the screen. (If the menu isn't visible, tap the screen anywhere except
on the map.)
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Changing Views:
Map/ltinerary/Guidance Toggle

NOTE: It is not safe to attempt to alter settings on your Pocket PC
while you are driving. Either have a passenger make changes, or pull
over to a safe area.

1. Map
le 1514 )4 "4
7 =
| N ey 7 ]
&) | & i

Tap the View Map button to
switch from any screen to see a
map of your current location.

e S Peicds [Traskdere]

In the Map screen you will see the area
'ﬁ. ﬂ around your current location. You can

Zoom In or Zoom Out and alter the map's
E E Detalil level using the toolbar buttons.

Tap on an exit ramp on the map and

the exit number will pop up (where

available).

2. Itinerary
5 1]
Turm Irsbruction Miks |4
A 32 Panrth 4,5
%11 East 1080
4 A Easd L |

% Ad Eost (Great ., 45
To go to the Itinerary screen, {H' ;_-;ﬂ:;“m Ef;‘ i
tap the View Itinerary # A4 Easa (Piccadl.., 08
button. I® A4 South (Henem,,. 03
il Gallory,

] =-

In this window you can view turn-by-

turn instructions to your next stop. 2
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3. Guidance

Take Ramp to
M32 South

Tap the View
Route button to 63.5
go to the Guidance
screen.

Take Ramp to

Driver Safety Screen Passenger Screen

In Guidance Mode you will receive turn-by-turn driving instructions. You can
change between the Driver Safety and Passenger screens by tapping this button in

the lower right hand corner:

The Driver Safety screen will only show maps as you approach your next turn or
when you're traveling slower than 10 m.p.h. The Passenger screen will always
show the map. Please keep your eyes on the road if you are the driver!

Customizing the Guidance Screens

The two lines above the ETA in the Driver Safety

LR ocreen can be customized. Tap either icon to cycle

= 55.0 mph between displaying the current road, nearest crossroad,
speed, current time, elevation, or nearest town. Both
lines offer the same display options. Note that only one line will be shown when

the Passenger screen is displayed.

The map display can also be customized. Choose
Options in the pop-up Tools menu, then select miles or
kilometers for distances; a North Up map view that always
considers north to be at the top or Heading Up view
that always tracks your route upward; and Box Zoom
(draw a box around the area to zoom to with the
stylus) or Drag Map (use the stylus to drag map to the
desired area).
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Trip Editing and Waypoints

To get to the Edit Trip screen from the Guidance screens at any time, tap the
screen anywhere except on the map to display the tool bar, then tap the Edit
Trip button. From here you can edit the current trip or add additional stops.

Now you can tap and hold on any stop to activate a pop-up menu that lets you
delete, map or change the order of stops on your route. This menu also
lets you designate a stop as a “waypoint” (tap Set as Waypoint). Waypoints are
not considered as stops in the Trip Itinerary, their purpose is to guide CoPilot’s
route calculations along roads that you choose. To change a waypoint back to a
stop, choose Set as Stop from the menu. Waypoints appear with “>>" instead
of a stop number on the Going To list.

Also, CoPilot ignores waypoints when calculating the ETA and distance to the
next stop, so waypoints can be used to get the ETA and distance to a stop that is
not your next stop (see Getting ETA’s and Distances below).

Edit Trip
button.

==21 \ht;“-lliﬂﬂlid. Tynddall
(1) Redciffs, Bristol, LI, BS1 ¢

Take ramp and at
Rouncdaboul bake lirst
exit on A312 South
[The Parkway)

The estimated time of arrival (ETA) and
distance to your next stop will always

be shown in the lower left corner of the
Guidance screens. After entering a destination,
tap the View Route button to display the
Guidance screens and see the ETA/distance.

If your trip has multiple stops and you want to
know the ETA for a destination that is not the
next stop, designate the stops between your
current location and the target stop as
waypoints as described in Trip Editing and
Waypoints above.
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Picking Stops From the Map

CoPilot Live enables you to pick a stop off the map when you don’t know the
exact address of your destination. You must be in Planning mode to pick a stop
and name it (choose Planning from the Mode menu). The stop you pick and
name becomes a Favorite, which you can then enter as a destination in any mode.

.'% e =] ity [Brisiod =l

1. Choose Planning from the
Mode menu at the bottom of the

L]
screen. 1121314151017 18 [210] = |=]®
olw[e[r[f]yu] I'I"n ml
ala gl I E|1]E0"
¥ Llw ila —
2.In the Edit Trip screen, tap bl | L [+

either Going To or Origin to
identify your location as one or
the other, then click the Pick
Stops button.

3. In the Pick Stops screen, enter a
city name or postal code in which you
would like to search for a location. If
you know a nearby address you may
enter that as well.

Bristol, LK
Pl s 3 name for the
locabon [Opbonall

4. Using your stylus, tap the area

on the screen that you would like to the address of the area you tapped

select. A short tap will display street will be displayed and you will be

names. Tapping and holding will prompt prompted to name that address

the selection screen. for easy reference from your
Favorites list.

5. In the screen that pops up,
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Detour Feature

CoPilot Live’s Detour Feature allows you to preview an alternate route before
deciding whether or not to take it. Perfect for situations in which traffic has
suddenly slowed ahead of you, the Detour Feature will generate an alternate
route and tell you exactly how much distance the new route will add to your
trip. You can then make an informed decision about whether you're better off
driving through the delay or taking the new route.

1. As you approach a delay, 2. Tap on the 3. CopPilot’s voice will
tap on the black screen Detour button to tell you how many miles
to make the toolbar appear.  request a new route.  the new route will add to

— your trip, and will begin
BAHREES

to give you new turn
Turn right on Park

instructions.
Street. Then turn left. H ﬁ Fn
+ "
= e U
Turm laft on Park
Streat. Then turn

4. If you decide to use 5. If you decide
the new route, just keep not to use the

driving. Your old route new route, tap 6. CoPilot will then
will be displayed in blue for  the Cancel Detour  return you to your
reference. button. original route.

Turn right on
Stanley Hill.
Then turn left.

e Turn right on Park
Slreel. Thean turn lell

Selective Routing

CoPilot Live allows you to be selective about the roads you take on your trip.
There are two ways to do this: 1) you can customize your Trip Itinerary in
Guidance mode so that CoPilot will avoid certain roads; or 2) you can guide
CoPilot’s route by entering stops as “waypoints”.

Avoiding a Road in the Trip Itinerary

— 1. Switch to the Itinerary screen by tapping on the

" View ltinerary button. The Itinerary screen provides a
@ list of all roads that you will be traveling on if you have
entered at least one destination. Once in the Itinerary
screen, you can edit your route using the Avoid button.

2. Highlight the road to avoid by tapping it
once.

3. Tap the Avoid button,

and CoPilot will calculate a
new route that avoids that
road. You can customize

your trip only once.

You can return to the original route that CoPilot
gave you at any time by tapping the Return to
Original Route button.

’ To Return to the Original Route:

Tailoring Your Route Using Waypoints

CoPilot Live lets you customize a route by designating some stops as
“waypoints”. Waypoints appear on the Itinerary but they’re not treated like
stops in Guidance Mode and or in routing instructions. You can enter a
waypoint along a road you want CoPilot to use, and CoPilot will guide you
through the waypoint along that road toward your destination.

To designate a location as a waypoint, enter it as a stop in the Edit Trip screen.
Tap and hold the location on the Going To list until a menu pops up, then choose
Set as Waypoint. Waypoints appear on the Going To list preceded by “>>" instead
of a stop number. To turn the location into a stop again, repeat and choose Set as
Stop. You can set as many waypoints as you like on a trip; however, CoPilot will

always recognize the last address in the Going To list as a stop. 38



Contact Integration

CoPilot Live allows you to link directly to Pocket Outlook to retrieve address
information. With just a couple of quick taps of the stylus, you can enter a con-
tact’s home and/or work address as your destination.

3. You can either scroll
through your entire list

1. From the Edit 2. To pull a contact’s
Trip screen, tap address directly from

the Address Pocket Outlook, tap of contacts, or enter
button. the Contacts button. the first few letters of
the contact you are
. looking for. Choose
% — either the Home or Work
address.

Address
button. Caita ¢ pavas | i
alw, Farls
al e, Tarek

W Home Ak (01 Wk Ackie
Sheat:

City':
Stats;

Fi 2H

4. Make sure that CoPilot has
found the exact address. Tap now be entered as a destination.
on the address, or tap OK Tap the View Route button
to confirm. and begin driving.

5. Your contact’s address will

Eckir
Fdmee | Tk, IR efale (H}
Bkl i -t

T JERE [ 11 | |
Tatdalwls [+ [+ [F[u]1]a]aliL]
b [ [ [4 [ [0 ] ]8]

'.;:.:J."I'l
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Tools Menu Options

E 5“ E! i:; g Select Options from the pop-up Tools

menu to jump to a screen that lets you

Turn right on St change various CoPilot Live application
settings and edit your Home or Work
address.

T dgrem T ———————— T e Py - B Bt
ﬁ:—. LT P _3
e oot || | s S
Wit () S —
- bl ol i
Bt e ————————————— s L Paghal  ——
| e Yol :_ rlk s i b
Ctersseery [t
im I -|r-r- | 7 o ot rhﬁmlr#l_l

Tap the Routing Tab Tap the Guidance Tab Tap the GPS Tab to see

to change your Vehicle to adjust the turn warning  the speed at which your
Type, Routing Type, and time and speech volume, GPS tracks will be played
Routing Options. RV routes and to display or hide GPS  back. From this screen
favor major roads and tracking on the map. you can tap the Delete GPS
avoid sharp turns and U-  Note on Speech: See Tracks button to remove
turns wherever possible.  Speech Volume, p. 26, for your saved GPS tracks.
Quickest routing is based  additional ways to adjust AutoScan will scan your

on the most practical the volume. Pocket device for any

route in terms of road
quality, terrain, and urban/
rural classifications.

connected GPS receivers
and automatically load the
appropriate COM Port
and Baud rate settings.
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Tap the Map Tab Tap the Favorites Tab to open the list of your

to choose between Miles and  Favorite Addresses. You can change the assignment
Kilometers, and a map display ~ of your Work or Home address as well as Edit
that always tracks your and Delete One or Delete All addresses.

position moving upward or
maintains north at the top.
You can also choose Drag
Map mode that lets you use
the stylus to drag the map in
any direction to a desired
location (versus drawing a
box around an area).

NOTE: When your favorites list is filled
(50), each new address will replace the
address that has been inactive for the
longest period of time.

POI Alert Options

From the Tools menu, select Live and then tap on POIs to set POI reporting
options. When POI Alerts are enabled, CoPilot will alert you to the presence of
points of interest as you approach them. You can set how far away you'll be
when you receive the alerts and which types of POIs should be reported. You
can also limit alerts to POIs right on your route, or include POls that are nearby.
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Modes

CopPilot Live has four modes of operation on the Pocket PC. Tap the pop-up
Mode menu at the bottom of the screen to select Guidance, Navigating, Walking,
or Planning Mode.

Guidance Mode

In Guidance Mode, you enter

one or more destinations, tap
the View Route button on the
toolbar, and start driving.

This mode provides you with
on-screen spoken driving
directions and other information
relevant to your trip, such as
estimated time of arrival and
distance to the next stop.

To receive driving directions and
other data, you must have a GPS receiver attached to your Pocket PC and the
receiver must be in a good position to receive signals.

v Guidance
Mawigating
Walking
Planning

S (Mode {Guidance)

Navigating Mode

While in Navigating Mode, CoPilot will track your position as you drive. Unlike in
Guidance Mode, you won't receive turn instructions or voice prompts. This
tracking feature is an ideal way to see your location on the map if you don’t want
to be distracted by CoPilot’s guidance features.

Walking Mode

Take CoPilot with you wherever you go! Walking Mode provides an as-the-crow-
flies distance and direction line to your destination, directions that are perfect for
walking. A GPS receiver must be attached and receiving signals.

Planning Mode

Planning Mode lets you use your Pocket PC as a pre-trip planning tool or easy-to-
use reference guide. Planning Mode lets you view static maps and directions
without the need for a GPS receiver. Trip itineraries you create in Planning Mode
can be saved and then loaded in any mode at a later time.
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The GPS Men
Status

BLBEEEE

Determining

Current
Position.

To view your GPS satellite
activity at any time, select
Status from the GPS menu.

Receiving signals-

B8RS
Determining
Current
Position.

Select Receiving from the

pop-up GPS menu to activate

or deactivate GPS satellite
reception. Receiving is active
if you see a check mark.

u

EHEEH [

:u‘l"

] ':p.l"hll-lnl

From this window you
can get additional

h:

Here you will receive
information on Speed, Lat/
Long position, Heading, and ~ satellite acquisition

Time and Date. Tap on
the Sats tab for more
GPS satellite information.

information. To get a
3-D fix (required for
CoPilot to locate your
position) you must have
four satellites “in the
green” for several
seconds.

ON  Receiving signals-OFF

ABBEEE
GPS receiving Is
off. Pls turn it on
for navigation.

Tap once to change the status.
If Receiving is inactive, CoPilot
will be unable to provide driving
instructions.
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Open and Play GPS Tracks

BhBBL/E

GPS receiving is
off. Pls turn it on

for navigation.

1. To open a GPS track,
receiving must be turned off.
Select Open Tracks to open a
Windows folder of your stored
.gps files.

2. To access a track, tap
once.

3. Select Play GPS
Tracks from the pop-up
GPS menu to begin track
playback.

4. During track playback you
can select Pause GPS
Tracks to stop the track from
playing.
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Pt o Py - Bl Bt

B OBES

Tuim righl an 51
e [ Michaels Hill

] B TN

T bk

4a. Playback can be viewed in any
window. To control the speed,
select Options from the Tools
menu, tap the GPS tab, and use the
sliding bar.

5. Select Close GPS Tracks
from the GPS menu to stop the
track from playing. To turn
receiving on, tap Receiving.

Save Current Location

You can use the GPS menu to save your current location as a favorite place. You
must be receiving GPS data to do this. Tap the GPS menu and then select Save
Current Location.

A prompt will ask you to assign a location name to your current latitude/
longitude position. After you enter a name, your current location will be saved
in the Favorites list.

NOTE: Remember that when your ——
favorites list is filled (50), each new E}. I} ﬂ
address will replace the address that Turn lefl on

has been inactive for the longest Parliament Strest.
period of time.

- 45 -

Reference: CoPilot Live Screens
What's What on Your Pocket PC

The following is a guide to the various features and shortcuts available from the
screens you will see on your Pocket PC as you operate CoPilot Live.

Edit Trip Screen

Shortcuts to: Home, Work, Favorites,
Address Input, Points of Interest, and the
View Route button.

Numbers identify each stop. The last
number is your destination.

Map shows area around your next stop.

Scroll to view more of the map.

Guidance (Passenger Screen)
Map will always be shown.

If toolbar is not visible tap anywhere

Take ramp and at
outside the map.

Roundaboul take first
axit on AZ12 South
(Tha Parkway)

b —

Next turn instruction.

Next turn arrow.
Route ahead highlighted on the map.
Customizable data display, tap icon to cycle

between current road, crossroad, speed,
current time, elevation, and nearest town.

Toggle between Driver Safety and Passenger
screens.

GPS Status, Messaging, and Traffic indicators.

ETA and Distance to Next Stop display.
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Guidance (Driver Safety Screen)
Map will only be shown as you approach turn.

Take Ramp to
M4 East

+ Baptist Milks, i
= 03U mpn

i 11:49 AN

No GPS Signal

BERRES
No GPS signal.

Please check
connections.

If toolbar is not visible tap anywhere
on the screen.

Next turn instruction.
Next turn arrow and distance to next turn.
Customizable display, tap to cycle between

current road, crossroad, speed, current
time, elevation, and nearest town.

ETA and Distance to Next Stop display

Toggle between Driver Safety and Passenger
screens.

GPS Status, Messaging, and Traffic indicators.

When you see this screen it means that
CopPilot is not receiving data from the GPS
unit.

1) Check that all your connections have
been made correctly, and that all wires are
secure.

2) Make sure your receiver is plugged into
your vehicle's power source.

3) In the drop-down GPS menu on your
Pocket PC be sure Receiving is checked.

4) Occasionally, when using the GPS
expansion pack without a power adapter,
this message may be displayed because
the expansion pack is powering down
temporarily to save power. Reception will
resume within a few seconds.
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Map Screen

Toolbar for easy access to Trip window,
Itinerary, and Zoom In/Out or More/Less
Detail.

Direction which your map is facing.
Area around current location

Scroll map.

Scale of Miles.

Exit numbers: Tap any exit ramp on
the map to see the exit number

Itinerary Window

~ |
-

% A East (Piccadi... 0.1
4+ A4 East (Piccadl,.. 0.8
| A Saiith (Haym... L3
@ rational Gallery,..

il
Turn Insiructicn Bile [
4 M2 Marth 4.5—] |
+ ™1l East 1050
+ L 1.1 | |
% A4 East (Greak,  J B
4 Hyde Park Cormer

[V

where available.

—— Toolbar for easy access to Guidance
screens, can also be used to avoid roads.

— Distance between turns.

— Direction of turns along your route.

[~ Names of roads for upcoming turns.

Tanls GF% Mude [Gudance ) =
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Address Input Screen

LR <) iy sl 3

Tap the Contacts button to select
an address from Pocket Outlook.

Enter a City/Postal Code for your

19 wale st

destination by typing it in using the

keyboard at the bottom of the screen.

Previously entered cities can be chosen
from the drop-down list. Tap the
Enter key or OK.

(Optional) Type a Name, then tap OK.

\ (Optional) Type a street address,
\ then tap the Enter key.

List of possible matches. Highlight one,

then tap the Enter key.

Enter key.

Points of Interest Search

_' Poonls o Dk er

u-,.{u{vlnn-h.mdm

Tvpe [Visitor Attractions

[——— Enter a City/Postal Code from

which you would like CoPilot to

search.

Select a category Type from the
drop-down menu, and tap Find.

/

(Optional) Type a name to speed up

%\ the search.

List of nearest matches to your search
criteria (within the area downloaded to

your Pocket PC), and distance from the
city you entered. Highlight one and tap
the Enter key.

Enter key.
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Trip Planning on Your Pocket PC

You can use Pocket CoPilot on your Pocket PC for trip planning whether or not
the GPS receiver is connected and receiving data. Planning mode allows you to
run a trip on your Pocket PC even when you're not in your car. You'll get driving
directions and maps that you can use for reference before your trip begins.

live

PocuET PC A

1. First turn on your Pocket PC.
To launch the CoPilot Live
program, click on Start and
choose “CoPilot Live” from
the drop-down menu.

Fhie Fruivlion wf 0P8 Hovigesan —_——

3. You'll see the same trip entry
toolbar buttons as in the Edit Trip
screen, plus a Pick Stops button. Tap
the Origin bar to enter an origin
and the Going To bar to enter your
destination and any stops. See p. 36
on picking stops from the map.

LROBOH

E”delh-mu-da“ﬂullq,

2. Select Edit Trip, then tap the
Mode pop-up menu at the
bottom of the Edit Trip screen
and select Planning.

| EEEESaEmE |
Feshy GFS M | s --

4. Click the View Route button
and your route will be displayed in
the Map screen. You can Zoom
in/out and alter Detail levels using
the toolbar buttons.
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. Tap the Itinerary button

to see the itinerary for your
planned trip.
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6. Tap the Map View button

to return to the map screen.

Saving and Loading Trip Itineraries

To save a trip itinerary you put together, select Save Trip As from the pop-up Tools menu.

Give the trip a name and tap OK. The itinerary can then be opened at a later time in

any mode.
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Dpen Trp

Uipdate License
IHelp
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L

Tk | GPS Made (Planmineg)|

Open Trip

Save Trip As
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Trip Planning on Your Desktop

On the following pages you will find brief descriptions of the trip planning
capabilities of the CoPilot Live desktop application. You can use CoPilot's
desktop functions to map out routes and print maps and driving directions before
getting on the road. This is an additional feature of CoPilot Live that is in no
way connected to using your Pocket PC for route guidance.

To access Planning mode on your desktop/laptop, click the Planning icon in the
sidebar to the left of the map.

-

To see CoPilot’s desktop trip planning functionality described in more detail, open
the CoPilot Live Help Files from within the desktop application (Help Contents
and Search in the Help menu or click the Help button on the toolbar). Go to
Desktop Trip Planning in the Contents tab. P

Menus and Toolbar Buttons

Using the drop-down menus you can select from a number of functions. Many of
these functions also have corresponding toolbar buttons:

CIRIE4ESE TN REY = =R VY hd

1. Open Trip
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gt g gli=]
| mdpringtiey FT
Open Trip button or Open
Trip...from the File menu.
S | | Liprem I
L L = e |
D i o

Takes you into a standard Windows folder
where you can select from trips you have
saved after running them in the Trip Planner.
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2. Save Trip

&

Save Trip button or Save Trip.../
Save Trip As... from the File
menu.

3. Edit Trip

<

Edit Trip button or Edit Trip
from the Trip menu.
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Takes you into a standard Windows folder
where you can name trips to be saved after
running them in the Trip Planner.
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Takes you to the Trip Planner window where you
can edit stops on your existing trip, arrange the
order of your stops, add or edit Favorites, and
search for Points of Interest. Click Run to
generate driving directions and a map, or use
your Contacts database to add stops to your trip.
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4. New Trip

New Trip button or New
Trip from the File menu.

5. Run Trip

LPies sid Plidwinsti. Puim o bamep §asmims Coruo
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Run Trip button or Run Trip
from the Trip menu.
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Takes you to the Trip Planner window
where you can create a new trip, arrange
the order of stops on your route, add or
edit Favorites, and search for Points of
Interest. Click Run to receive driving
directions and a map.

ST A g N W

Generates the route. Will show a detailed
Trip Summary, and display a map and driving
directions for the route that was run.
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6. Print

Print button or Print... from
the File menu.
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Takes you to the standard Windows Print

menu to print the active window that contains
your map or driving directions. Activate one or
the other window by selecting from the drop-
down Window menu. Select Print TravPak...
from the File menu to print driving directions,
an overview map, and a zoomed map of each
stop.

Help button or Help Contents
and Search in the Help menu.

Opens the Help Files at the Table of Contents.
From here you can search for help by topic,
use the Index, or Search for a word or phrase.
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8. Data Download Wizard

Data Download Wizard
button or Data Download
Wizard from the File menu.

9. Zoom Out
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Takes you to the first screen in the Data Download
Wizard where you can specify the location where
you want downloaded data to reside on your
Pocket PC.

10. Zoom In

Zoom Out/Zoom In buttons or Zoom Out/Zoom
In from the Map menu.

Each time you click on one of these buttons,
your view will be zoomed in or out by one
increment. The zoom level is shown in the title
bar of the map window.
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11. Less Detail

|
Bl FRE SRR

12. More Detail

[T
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More/Less Detail buttons or Detail from the Map menu.

Clicking on these buttons once will change the level of
detail you see on the map by one increment
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13. Zoom to Region

The Zoom to Europe button or Zoom
Region from the Map menu. This
function allows you to zoom your
map view to a specific region.

14. Refresh Map

Refresh Map button or Refresh Map
from the Map menu. When scrolling
through a map you may notice it takes
a few seconds for all the data to catch
up. This function will snap the entire
screen to a new map.
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15. Pick Stops

A

Click the Pick Stops button to turn on Pick Stop mode and
enter a stop by picking it with the mouse from the map.
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You can then choose to enter it
Once Pick Stops mode is enabled, as a start place, a waypoint, or a
click on any point on the map to destination.
select that location.
16. Preferences
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Select Preferences from the
drop-down Edit menu.

In this window you can change the
way you view your desktop maps and
various application settings.
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17. Landmark Reporting

Select Landmark Reporting from
the drop-down Trip menu.

18. Help Menu
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In this window you can control how
many Landmarks CoPilot points out
when generating driving directions.

Use the drop-down Help menu to
access the CoPilot Help Files for
assistance with all aspects of the
software. In this menu you will also
find helpful travel links, a link to the
ALK Web site, and a link to the ALK
data corrections e-mail address. With
street-level data changing every day,
you may discover some errors.
Please drop us an email. With your
help we will be able to improve our
map data with every update.
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Reference: Desktop Trip Planning

What's What on Your Desktop

CoPilot Live on your desktop includes many options, special features and
shortcuts. The following is a guide to the main screens you will see as you use
your desktop/laptop computer for trip planning.

Map Window

Menus and toolbar buttons
to access all of CoPilot's
desktop features.

[ Click on a tab to frame any

stop on your route.

—— Map of area around your

destination. Move your
cursor over a street to
view its name.

[~ Distance Scale.

Direction the map is facing.

Trip Planner Window (Cities & Addresses)

T

n Lams. Swindan UL

Wies | T Oam| gpses | Sesd |

Select tab for address input.

Enter city name/country
or postal code. Enter
an address (optional), with
the option to add a Name
to it. Click the Add Stop
button to add the stop to

the ltinerary. o™

Use icons to move stops up
or down on your ltinerary,
zoom to stop location on the
map, delete a stop, or add a
favorite.

See p. 63 for Routing Options.
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Trip Planner Window
(Points of Interest)
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— Select Tab for Points of Interest.

Enter a city or postal code

search, a radius within which

to search, choose a category
and type from the drop-down
menu, and click the binoculars
to search. You can also enter a
name to narrow down the search
in the POls that start with

box.
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You will be given a list of matches
to your search criteria.
Highlight your selection and
click Select. Click the Add
Stop button to add it to your

i Itinerary.
il [ ]

Trip Planner Window (Favorites)

T L 1) )
i and Rdirems Frien ol meien — Select Tab for Favorites.
e |
T juwm Celage ) A )
ol Highlight a selection from
~E : your list of places by clicking
T P i RL-E on it. You can zoom to it on the
map, or Delete it from the list
W a using the buttons to the right.
iyl B Click the Add Stop button to
| add a favorite to your Itinerary.
W | T paw| pprem | Swna | oM ]
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Trip Planner Window (Contacts)
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[CEr—— «_1=l_— Enter a person’s first or last

name and hit <Enter>.
CoPilot will search your
Contacts database for matches.

— Select the Contacts address
type (as defined in Outlook) to
get the appropriate address,
then click the Add Stop button
to add it to your Itinerary.

[ oM |

Driving Directions and Map (Split Screen)

When you click Run in the Trip Planner window, your route will be calculated
and driving directions and a map will display. To print either one, click on it and
choose Print from the File menu. To print directions plus all map views, choose

TravPak Printing.

Driving directions give you

turn-by-turn instructions including

ramps and exits, and distance
and time between turns.

Atlas, Start, and End tabs will

zoom to the map view of

those places respectively.

L a——
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Routing Options

Click the Options button in the
Trip Planner window to access
CoPilot routing options.

EET T = . . .
H.,H///_I Auto Quickest is the default setting,
& e, o _®_t and provides the quickest routing
K e |

- A for automobiles based on

[ ——"— practical considerations such as
¥ Qe road quality, terrain, and urban/
L rural classifications. RV routing
Mg s i favors major roads and avoids

il
T v 1ol EEE sharp turns and U-turns where
[~ Basiasy | i [ |2 e ) possible.

~ Click Advanced to set general
road preferences.

Drag the sliding bars to the left
or right to avoid or favor each
road type.

Set the road speeds CoPilot uses
in its route calculations for each
type of road by either typing or
clicking the up and down arrows
under Rural and Urban for each
road type.

Select Run from the Trip Planner
window to run the trip you enter.
Your trip will be calculated based
on addresses specified.

Summary will show start, end, and
number of stops in between.

Total distance and time for trip.

Click OK to view map and
driving directions.

- 63 -



CoPilot Live Communications

CopPilot Live now allows you to maintain two-way communication with drivers
who are using CoPilot and to actually see where they are currently located using
your home or office PC.

Using this CoPilot Live functionality requires the following:

1) CoPilot Live open on your home or office PC. Your PC must be
connected to the internet.

2) CoPilot Live running in the vehicle. Your Pocket PC must have a wireless
internet connection. (Visit our website at www.alk.com/cp4 for a list of
recommended hardware configurations.)

To begin using CoPilot Live functionality on your desktop, click the Live icon on
the sidebar to the left of the map. The upper portion of the new pane that opens
is the Vehicle List. Your connection to the CoPilot Live network is displayed
above the Vehicle List.

The login ID of the driver is displayed on the Vehicle List, with columns for the
vehicle's next stop, ETA, speed, location, and time of last update. To see all
columns, expand the pane by placing the cursor on the right edge until it
becomes an arrow and dragging.

Below the Vehicle List is the Message Center. The text of sent and received
messages will appear here.

NOTE: All of CoPilot Live's communications are done in real-time. This means
information is only transferred when the driver in the vehicle and a user on a
home/office PC are using CoPilot Live at the same time. In this sense CoPilot
Live communication is similar to using a telephone - communication only occurs
when both parties are on at the same time.

ALK does not actively log a driver's location information, nor do we use this
information for any purpose other than to transfer it to a home/office user.

T O T
Server Name T T =T
E o remciam cween B e

Vehicle List ——|

Messsage
Center

Y

- 65 -

Pocket PC Setup
Under Tools > Live tap the

Messenger tab. From here you can

E] Erbds Meisagrg toggle messaging on or off and specify

(] Ensbis Timmout of ressages how often data is transferred.

Zard to Sarvar )

= Depending on the plan offered by your
T T T wireless data service provider, sending
Prouency £ =] Seconds less data at infrequent intervals will be

[ Dastinatian, ETA more cost-effective.

hmEI Lo

Tapping on the Login tab will give you
the ability to change your screen name
as it appears on the home/office PC.

Automatic Vehicle Location (AVL)
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On your desktop CoPilot Live tracks the location of the driver. Double-clicking
the vehicle in the Vehicle List will center the map on the driver's last reported
location. The vehicle location updates at an interval specified by the driver on his
Pocket PC (see Pocket PC Set Up, above) as long as both you and the driver are
running CoPilot Live.
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Send/Receive Messages - Desktop

To send a message to the driver, click the Send Message button on the toolbar.

Standard Response /
Buttons

Text to Send /

Customizable Italian
Response Buttons $E|Ed

Send Button

B2 ¥

pant for dinner?

Changes Number of Customizable
Response Buttons

Click your cursor in the space just below the Standard Response Buttons,
and begin typing.

The Standard Response Buttons are included in every message and are described
in detail in Receive/Respond To Messages - Pocket PC (p. 69).

You have complete control over the Customizable Response Buttons:

1) Choose to display 1-4 buttons by clicking the corresponding number at
the bottom of the screen.

2) Change the text of each button - the driver will see whatever text you
enter and when the driver responds, the text of the button will be sent
back to you.

Once you have typed your message and specified your Customizable Response
Buttons, click the Send button to send your message to the driver.
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When the driver responds to your message, the response is displayed in the
Message Center:

= CoPitot Live - Map detsil ovel 11 of 17 1)
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Message and Driver’s Response

Advanced:

Clicking on the Advanced tab of the Send Message window will expand the
view. From the Advanced view you can save frequently used message text and
button layouts that you can recall for future messages.
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Receive/Respond To Messages - Pocket PC Send Trip Itinerary Updates - Desktop

- = v To send a Trip Itinerary Update to the driver, click the New Trip button on the
- @ ? ' toolbar and create a trip itinerary in the Trip Planner window just as you would

What do you
want for dinner?

in Planning Mode (see p.60). [

E et

Then click the Send button:

Trip Planner Window
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When you are the driver and a message is sent to you, CoPilot Live displays it .I'.

on top of all other windows. If you have CoPilot Live's text-to-speech engine
installed, when a message is received you will hear the text of the message i T haip
spoken out loud.

Trip Hinmy
On the top are the four Standard Response Buttons which appear on every ) Send Button
message: T
Speak Message: CoPilot Live's text-to-speech engine | B b | X Caer | Gptinns | L_jimd imairrshin.
speaks the text of the message
Send Tipaz:  |BELDi= 3 S o
Defer Message: Defers the message, which will reappear Trp Ophara
later. Useful when you need to concentrate - Fagleik tueest iy X Carncw
on the turn instructions and the road. Ser_ld Trlp / 2 Jad o v W]
Confirmation 2 aw Lt EOpk
More Information: Sends a response back that you need
more information. |
Y Delete Message: Deletes the message-notice of the delete In the Send Trip Confirmation window you can specify whether you want the
w is sent back. new trip itinerary to replace the driver's existing trip, add as the next stop(s) in

the driver's current itinerary, or add as the last stop(s) in the driver's current
itinerary. Click OK to send the trip itinerary.
You can also tap one of the Customizable Response Buttons at the bottom of the

screen that the message sender has included. The text on the button is sent NOTE: CoPilot Live always uses the driver's current location as the start point
back. for giving route guidance.
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When the driver responds to your trip intinerary update, the resonse is displayed

in the Message Center:
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Send Trip and Driver’s Response
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Receive Trip Itinerary Updates - Pocket PC

. '@ " ? - i-
1. 715 Market Streat,
Philadelphia, PA

When you are the driver and a Trip Itinerary Update is sent to you, CoPilot Live
displays it on top of all other windows. If you have CoPilot Live's text-to-speech
engine installed, you will hear the itinerary updates spoken out loud.

The four Standard Response Buttons appear (see p. 68 for more details on these
buttons).

You can Accept or Decline the change to your trip itinerary. If you accept the
change, CoPilot Live will automatically start giving route guidance using the new
itinerary.
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Helpful Hints

Installation

Your Product Key Code can be found on the cover of your printed Quick Start.

One-Touch Access to CoPilot

You can program one of the buttons on your Pocket PC for one-touch
access to CoPilot Live. Select Settings from the Start menu, click the
Buttons icon, highlight the button you would like to program by clicking
on it, and select CoPilot Live from the drop-down Button assignment: menu.
In future uses pressing the assigned button will immediately launch CoPilot.

GPS Tracks

CoPilot Live will automatically track your trips and save them as .gps files on
your Pocket PC. You can play back a .gps track at any time to review a
previous route. To save memory space on your Pocket PC, you may want to
empty this folder occasionally and transfer the track files to your desktop PC’s
hard drive. To do this, follow these steps:

1) Connect your Pocket PC to your desktop using ActiveSync.
2) In the ActiveSync window, click Explore.

3) Open the GPS Tracks folder, and cut and paste the .gps files to a folder on
your desktop PC’s hard drive.

NOTE: These files are also helpful to us. Using your GPS tracks, we can
enhance the street-level system to provide even more accurate map data with
each new release. Occasionally, please take these files, zip them, and send
them to ccptrax@alk.com. Or open CoPilot on your desktop PC while your
Pocket PC is connected via ActiveSync, then select E-mail tracks to Club CoPilot
from the GPS menu in CoPilot on your desktop.

About GPS Technology

The Global Positioning System (GPS), developed by the U.S. Department

of Defense, is a constellation of 24 satellites that orbit the Earth twice daily.

Each satellite contains an atomic clock that is accurate to the nanosecond, and
constantly emitting radio waves toward Earth. GPS sensors (hardware devices
for receiving data) can receive these signals from the satellites, and using their
own internal clock can calculate the amount of time it has taken for the signal to
be received. GPS relies on the fact that radio waves travel at the speed of light
to calculate distances, and the exact location of the sensor is figured by
combining the data received from four satellites. Using the data from these
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four satellites, GPS is able to give you the latitude, longitude and elevation of
your present location, and also your road speed and direction of travel on a
route. Given the right conditions, a GPS sensor can identify your geographic
position anywhere in the world within a matter of a few meters.

How CoPilot Live Uses GPS

CoPilot Live uses the GPS positional data that it receives from the hardware unit
you place on your dashboard to display your current position on a map as you
drive. This is called "tracking". CoPilot also uses the GPS data it receives to
guide you along your planned route, provided you enter a destination on your
Pocket PC. CoPilot Live guides you with audible prompts as you drive as well as
on-screen directions.

Tracking will begin automatically when you have satellite reception. In order to
get route guidance you have to enter a destination on your Pocket PC. Tracking
may also be used without receiving guidance instructions when you're in
Navigating Mode. In this case, you'll see your trip tracked on the map on your
Pocket PC as you drive, but you won't see a highlighted route on the map and
you won't be given driving directions.

GPS Accuracy

The GPS signal CoPilot Live receives from the constellation of satellites

has a rated accuracy of within 5 - 10 meters. This means that 95% of the time
the reported location is within 15 - 30 feet of your exact position. CoPilot takes
this location information and enhances it further by "snapping" it to our street
and highway network. Occasionally, CoPilot will place you on the wrong road. If
this occurs, keep driving and CoPilot will automatically correct itself and find your
proper position.

At times, CoPilot Live's GPS tracking will be less accurate or fail to work at all
because the unit is unable to receive satellite signals. Heavy foliage, tall buildings,
or any other structures obstructing communications will interfere with CoPilot's
ability to track your location. Like your car radio, GPS tracking can also be affect-
ed by weather conditions if severe. CoPilot Live will continue tracking as soon as
adequate signals are available. Despite these limitations, you can expect CoPilot
Live to provide you with useable and accurate information most of the time.
CoPilot Live will alert you if accurate information is unavailable.
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Trouble-shooting

Why can't | get a satellite reading the first time | use CoPilot Live?

The first time the GPS receiver is used it may take approximately 5 minutes to
acquire a signal (but may take as long as 15 minutes). You can minimize this time
by remaining stationary and positioning the GPS receiver so that it has a clear
view of the southern sky. Once initialized, the unit should acquire satellite signals
in 40 seconds or less in the future.

How can | speed up satellite acquisition?

Be sure that the GPS receiver has an unobstructed view of the sky. Trees,
buildings, and other obstacles are capable of blocking the satellite signals. You
might also want to purchase an active external antenna from your CoPilot
supplier to speed up GPS acquisition.

In the drive screen on my Pocket PC | am receiving turn-by-turn instructions in the black
box, but my CoPilot Live is not speaking. Why is that?

CoPilot Live provides voice prompts each time you come up on your next turn.

In order to hear these prompts you need to be sure the volume on your Pocket
PC is turned all the way up. On the Pocket PC in the Start menu go to Settings,

and click on Sounds & Reminders. Under System volume move the slide bar all the
way to the right.

You can also use your Pocket PC’s keypad to adjust the volume. Tap up to
increase the volume, tap down to decrease it.

Will CoPilot Live work with a GPS receiver that is not made by ALK Technologies?

Yes, you can use a third party receiver with CoPilot Live. See p.1 of this User’s
Guide for a list of compatible types of receivers.

GPS PROBLEMS

If you do not get a GPS signal please check the following:

1. Under GPS make sure there is a check mark next to
Receiving.

2. If not, tap on Receiving to check it on. If you are unable to
place a check mark next to Receiving by tapping on it, press the
Reset button located on the bottom or back of your Pocket PC
while CoPilot Live is open and the GPS unit is connected.

3. Once you hit the reset button, open CoPilot Live again
and make sure there is a check mark next to Receiving.
Your GPS unit should now acquire a satellite fix.
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Using Help Files

CopPilot Live provides extensive Help Files, available on your desktop/laptop and
your Pocket PC, to guide you through the program as you use it.

To access Help on your Pocket PC, once the CoPilot Live application is launched,
tap the Tools pop-up menu at the bottom of the screen and select Help.

Click on the Help button in any window in the desktop application to open a
Help topic that describes how to use that window. For example, if you're
searching for points of interest in the Trip Planner window, the Help button will
open Help at the topic Finding Points of Interest. From there, you can navigate
through other topics, or do a search on a topic using the Search tab.

Another way to access the Help Files on your desktop is through the Help menu.
Contents and Search will open Help at the Table of Contents, which displays the
main topics available. Topic Search opens the Search tab.

Technical Support

After registering your software, you're entitled to technical support and discounts
on future updates.

Check out our Internet site at http://www.travroute.com/europe for
technical support documentation, posted answers to common questions, and
upgrades. You may also e-mail us at eutechsupport@travroute.com. Please
include your Product Key Code in your message. This code can be found on the
front cover of the printed Quick Start that came with your CoPilot package.
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